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Introduction
SpEdDoc 7.0 or newer contains mandated state special education (released in 
August 2008) and Medicaid forms (released in July 2008), but look to the Ver-
mont DOE and your special education director for guidance concerning the im-
plementation of these forms. This manual is organized according to the files in 
SpEdDoc (paralleling the tab and button rows found at the top of most program 
layouts). 

The manual is continually under development to reflect the latest SpEdDoc ver-
sion. Consequently, you will need to run the latest version of SpEdDoc in order to 
access all the features referenced in the manual. SpEdDoc 7 requires FileMaker 
Pro 7, 8 or 9. However, some SpEdDoc features require FileMaker Pro 8 or 
newer.

The current version of the manual is posted on the SpEdDoc web site: www. 
SpEdDoc.org. There you will also find guides on specific topics such as Medi-
caid.  As always, feedback on the manual and SpEdDoc is much appreciated. 
Contact Richard Smith at speddoc@verizon.net.

Begin

Log in (for Case Managers)

Launch SpEdDoc with the SpEdDoc.fp7 file. For stand-alone users, this is lo-
cated in the SpEdDoc Folder on your computer. For your convenience, you may 
create a shortcut to that file. Network users should get directions from your net-
work administrator to connect to SpEdDoc over your network. The Start SpEd-
Doc file 7 is available for configuration to simplify remote connections from a 
FileMaker client.

To use SpEdDoc, you need to know the Account Name and Password (revised 
for SpEdDoc 7, so check with your database administrator regarding the Account 
Name and Password). Further, to access a caseload, you’ll need your personal 
User Code. These are generally assigned by your local database administrator. 
Or, if you are just starting out and no students have been entered into the data-
base, you can create your own User Code. Given the confidential nature of spe-
cial education data, your User Code needs to be secure.

Enter the same User Code every time you log in to access your caseload. Each 
case manager needs a unique User Code because SpEdDoc uses the code to 
automatically enter the case manager’s identity on many forms and to permit ac-
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cess to the case manager’s student data. Users without a caseload do not need 
a User Code, but instead use an administrative password (see instructions in the 
next section).

Enter your User Code and click the Submit button (do not press the Enter key 
because that will change your User Code). If you already have entered students 
under that User Code, a list of their names appears to the right of the Submit but-
ton. The list is alphabetical (scroll down to view the end of the list). You can click 
on a name to go to that student’s Main Data record in the Student file or click on 
the Go Students button to go to the List View. 

Tip: SpEdDoc alerts you if you enter a new User Code. When you log in with a 
new User Code, a dialogue box states that you have no records based on the 
User Code entered. If you do have records, check your User Code and reenter it. 

Log in (other than Case Managers)

With FileMaker Server, personnel other than case managers can access the data 
over the school network. These personnel can be given access at the student, 
school or SU-levels. Student level access is provided through User Codes (be-
sides the primary case manager, up to two additional users may be assigned to 
each student). The school password allows access to all records with that school 
in the CM School field on Student: Main Data. The SU password corresponds 
with the Org ID field on Student: Main Data. If you enter the wrong password or 
have no records that correspond to the password, then you will see a message to 
that effect. School and SU-level passwords are entered in the Begin: Admin lay-
out. Passwords may be obtained from your local database administrator.

Even if you are not a case manager, you will need to know User Codes if you en-
ter new students in SpEdDoc on behalf of case managers. Enter the appropriate 
case manager’s User Code in the Begin file prior to selecting the New Student 
button in order to place the student on the case manager’s caseload.

Student

Entering and Managing Student Records

Once in the Student file, you can manage existing student records or start new 
ones. Locate students in the Student file with one of several methods:
• Click on List View on the button row below the Student tab. On List View, click to the 

left of the student name to go to that student’s Main Data. 
• Navigate between students by clicking on the book icon on the upper left of the layout 

just under the Layout menu. 
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• Select the Find button on the bottom of the screen, type part of the student’s name in 
the Student Name field and click Continue.

• Use the Student Name as Popup field at the bottom of the Find screen network users 
may experience a slowdown with this method). 

Tip: You can usually tell where you are in SpEdDoc by viewing the top of the 
screen. The top row of tabs show which file you are in while the row of buttons 
below the tabs show which layout you are on (the current file and layout names 
are blue). 

If you don’t already have a record for a student, check with your SpEdDoc admin-
istrator to see if a record exists elsewhere (if so, the existing record can be trans-
ferred to your caseload). Otherwise, create a new record by clicking on New Stu-
dent on the bottom left of the Main Data screen. This takes you to the Main Data 
screen where you can enter the name of the student along with other information. 
Enter information thoroughly on this screen before creating documents because 
information automatically transfers at the time forms are created. The Facility is 
the school the student attends while the CM School is the case manager’s 
school. The CM School should be in your SU to ensure that all password levels 
provide access (assign a CM in your SU even if another SU has child count re-
sponsibility).

Dates in the Main Data Tracking box fill automatically from the cover pages of 
IEP’s and Evaluations. To enter dates when these documents have not been cre-
ated in SpEdDoc, click on the Tracking button (below the row of tabs at the top of 
the screen). In Tracking, enter the Initial and Most Recent eligibility dates as well 
as the IEP Meeting and Initiation dates. These update automatically on Main 
Data when you create IEP’s and Evaluations in SpEdDoc. For students with 
Services Plans, enter those Meeting Dates in Tracking as well. Enter the other 
fields in Tracking if you are instructed to do so by your administrator.

The Contacts bold label fields under Primary Contact transfer to documents and 
is used for child count, so Contacts should be completed ASAP. While they don’t 
transfer to documents, the Secondary and Other Contacts may be completed for 
convenient reference.
 
Tip: Each student may have multiple IEP’s and other documents in SpEdDoc, but 
should have only one record in the Student file. Always be sure to check before 
starting a new record in Student. If you create multiple records for a student in 
the Student file, you will eventually have to delete the multiples and may lose 
some data in the process.

Notes and Contact Logs
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Click the Notes button in the Student file to access a screen for entering notes. 
You can enter up to ten pages of notes per student.

Click on the Contact Log button to enter an unlimited number of dated contact 
notes. On the Contact Log screen, click the Add New button to create a new en-
try. To print the current entry, click on the printer icon to the right of the entry. To 
print the current set of entries, click on the Print Log button. To select a set of log 
entries to print, use the All Logs List button, enter Find mode (click on Scripts on 
the FM toolbar above the layout and select Enter Find Mode) and then use File-
Maker Find techniques.

Tip: With FileMaker 8 or newer, users can enter a contact message and then 
click the envelope icon to transfer it to your email program. This allows you to 
maintain a record of email correspondence related to a student in SpEdDoc. Fa-
miliarize yourself with local policies and procedures related to email correspon-
dence before using this feature.

Navigating and Creating Documents 

Navigate to other parts of SpEdDoc in two ways. One method is to simply click 
on a tab at the top of the screen, e.g., if you click on IEP, then you will go to an 
existing IEP for the current student. If there is no IEP for that student, you will see 
a Message giving you an option to go to Portals to create a New IEP or, if you 
select Open, to go to a list of existing IEP’s for other students. 

The second method is to navigate through Student: Portals. There you will see 
an overview of the sub-records for the current student, e.g., IEP, Evaluation, 
Meeting and Written Agreements (click on the Medicaid tab in Portals to view 
sub-records dealing with Medicaid or the 504 tab for 504 sub-records). In Portals, 
there are buttons on the left for creating new sub-records. To go to an existing 
sub-record, click on the Go arrow at the beginning of the line containing the sub-
record. To permanently delete a record, use the trash can icon at the end of the 
line containing the sub-record (this deletes all the documents on that line). If you 
create multiple sub-records for a student, you can scroll between them in Portals. 

Exporting Records (Stand-alone SpEdDoc)

Note: This manual only contains instructions for stand-alone users in the next few 
sections (Exporting, Transferring, Importing and Archiving Records). Network us-
ers may not have access to the deleting, exporting and importing features (in 
which case the SU/SD office handles this function following instructions in the 
Transferring Records guide).

To move student records between separate SpEdDoc databases, those records 
need to be exported to the Transfer file (see the Transfer Student Records guide 
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for a more detailed exposition). Once data is exported to the Transfer file, the 
Transfer file can be moved to the receiving computer so the records can be im-
ported. If your Transfer file is out of date, you will get a message that the data 
cannot be exported (until you obtain a current Transfer file). The current Transfer 
file is distributed as part of each SpEdDoc update and should be located in the 
SpEdDoc Folder located on the root level of the hard drive (stand-alone users 
should also have the SpEdDoc interface and data files in the same location). 

To export data, go to Student: Main Menu and select the Export to Transfer but-
ton in the Operations section. On the right hand side of the Export to Transfer 
screen, view a list of any records that are already exported. Click Delete Transfer 
Records to ensure that old export data doesn’t mix with your new export. Then 
click a button to select all your records (based on your User Code) or just your 
Active records (based on the Status field in Student: Main Data). Or you can click 
Find to go to a screen where you can identify specific students for export and 
then click Continue to return to the Export screen. The students selected for ex-
port will be listed on the bottom of the Export screen. 

Also click the check box on the lower left of the Export screen to export records 
to a new case manager (this removes your User Code and identity from the ex-
ported records). Then click the Export button to export the selected student re-
cords. After the export is complete, you’ll see the Import Log dialog indicating 
whether the Export was successful. Click OK to go to the Transfer screen show-
ing a list of all the records that were exported. The exported data is in the Trans-
fer file located in the SpEdDoc Folder (the same folder that contains the SpEd-
Doc files). When done with the export process, click the Go to SpEdDoc button to 
leave the Transfer file.

Transferring Records

To transfer exported records, quit FileMaker and copy the Transfer file (located in 
the SpEdDoc Folder) to media such as a floppy disk, flash drive or CD. The re-
cords in the Transfer file remaining on the computer should be cleared to ensure 
that the data is not re-imported and does not become mixed with data from future 
exports. You can also delete those students from your working database if you no 
longer need those records. Do this by locating the student to be removed in Stu-
dent: Main Data > Delete Student. Note that it is useful to retain SpEdDoc re-
cords for a year for child count reporting and DOE monitoring activities (written 
records need to be retained longer). 

Importing Records

To import records, copy the Transfer file containing those records into your 
SpEdDoc Folder.  Then go to Student: Main Menu > Import from Transfer. At the 
Import screen you will see a list of the student records that are in the Transfer file 
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(assuming you have access to those records). Select the Import button. When 
done, you will see the Import Log. Click OK to return to SpEdDoc and examine 
the new records to verify that they imported properly. The records in the Transfer 
file should be deleted to ensure that the data is not re-imported and does not be-
come mixed with data from future exports. 

Importing from Transfer requires logging into SpEdDoc with a password that pro-
vides access to the records (consequently, it is important that the “New Case 
Manager” button was selected when the records were exported to the Transfer 
file before sending to the new SU/SD).

Tip: Importing data replaces any matching student records. Before importing, 
make sure that you are not replacing current student data with outdated data.

Backing Up Records

To back up the entire database (the data with the forms), copy the SpEdDoc and 
SpEdDoc_Data files to media such as a CD or flash drive.  This method is useful 
prior to upgrading to new forms because it allows you to view the old data in the 
context of the forms that were used when the documents were created.  Also, it 
makes it easy to return to your old database if you find a problem with the up-
graded one.

Tip: It is not good practice to keep multiple copies of SpEdDoc on a computer 
because the databases can become intermingled. Save backups to media for 
safe storage. If that is not an option and you want to store the old databases on 
your computer, you may compress them. 
 

Spell Check

To check spelling, go to the FM toolbar and select Scripts > Check Field Spelling. 
This checks words in the current field (the field that your cursor is in). To check 
words on the entire layout, select Scripts > Check Record Spelling. Spell check 
can also be accessed with a single click on the Standard toolbar above the File-
Maker window (click the icon with a checkmark below ABC). If the Standard tool-
bar is not already active, select it from the FileMaker toolbar (View > Toolbars > 
Standard).

In FileMaker 8 or newer, questionable words in the current field (words not in the 
dictionary) are underscored with red dots. To obtain assistance with an under-
scored word, right click on the word (Control-click for Macs) and select Sug-
gested Spellings. The first time you add words to the dictionary, you first need to 
select a dictionary:
• Go to Edit - Spelling - Select Dictionaries and click Select Dictionaries
• In the Select Dictionaries dialog, click New
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• Name the file (e.g., User Dictionary), select a Save location (e.g., navigate to the 
SpEdDoc Folder on the root level of the hard drive) and click Create.

• In the next dialog, select the second option (i.e., Use Main Dictionary and User Spell-
ing Dictionary) and then click OK.

Once the User Dictionary is created, FileMaker can learn words. When a user right 
clicks on a red underlined word and selects Suggested Spellings from the contextual 
menu, the option to Learn the word appears below the Suggested Spellings list. Click on 
Learn to add the word to the dictionary.

Lists and Reports

A variety of Lists and Reports are available in Student: Main Menu. Lists can be 
sorted simply by clicking on the italicized headings, e.g., in IEP Due, click on the 
IEP Due heading to sort by due dates (those with no date show first, followed by 
those with earlier due dates). Customize lists using buttons on the bottom of the 
layout. Click on Active for User to display only your active students (based on 
Status in Student: Main Data) or All for User to include all the students on your 
caseload. For example, you might select Active for User so that your list doesn’t 
include New Referrals and Exited students. Admin users can use the Show All 
button to view all the students that are accessible under the school or SU pass-
word.

Click on the Find button to refine your criteria further. For instance, if you select 
Grade 5 for Grade and Emotional Disturbance for Primary Disability, then you will 
get all your Grade 5 students with that disability. Then select one of the Lists or 
Reports to view the found students.

Reports summarize data according to preset criteria. Many of the Reports are 
designed with school and SU level users in mind (e.g., they summarize by case 
manager).  Other Reports summarize by grade, placement or disability. When 
done viewing a Report, click on the Continue button. Then print or cancel printing 
to return to Student: Main Menu. 

The Find Services report has its own sophisticated find and reporting capability 
for IEP Services, as detailed in the Find Services Guide.

The Plan Date by CM and Eval Date by CM reports automatically find records 
with a CC Status of Active, Tuition or Unilateral. Find IEP’s or Evaluations that 
are coming due by entering a number next to the List or Report button on Stu-
dent: Main Menu. For example, enter 30 next to the IEP Due List button and then 
click on the button. This will yield a list of students with IEP’s due in the next 30 
days (or overdue). 
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List View automatically flags IEP’s and Evaluations for students with an Active  
CC Status that are coming due or overdue. IEP’s that are due within 30 days and 
Evaluations that are due within 90 days have yellow flags while overdue is indi-
cated by a red flag. Select Active or Exit in CC Status on Main Data for students 
who will be reported in the current child count census. Use the other CC Status 
choices for students who are not part of the current child count or will be reported 
by another SU/SD. The CC Status choices are:
Active: Currently special education eligible.
Exit: Exited since the last CC report (6/30/08). If you need to report students who were 
missed in the 6/30/08 CC report (students exited 12/2/07-6/30/08), then be sure to 
check the “Exited previous period” button below the Exit Reason.
New: Under evaluation but eligibility not yet determined.
None: None of the other CC Status choices apply (e.g., students exited in a previous 
CC reporting period).
Tuition: Special education eligible and receiving services in your SD/SU, but will be re-
ported for CC by another SD/SU (e.g., school choice students from another SD/SU).
Unilateral: Special education eligible, but will be reported for CC by another SD/SU 
(e.g., students placed by the family in a private school outside your SD/SU).

Auto-Fill Data

Data entered in Student automatically transfers to documents when you create 
them, e.g., when you go to Student: Portals and select New IEP, Eval, Medicaid 
or Meeting. Most of this data does not automatically update in existing docu-
ments when you make changes in Student (the student’s name, CC number and 
birth date are exceptions). This is so old documents reflect data that was accu-
rate at the time they were created. However, you may wish to update an existing 
record because you discovered an error. In that case, update the Student data, 
go to the document, click on Scripts on the FM toolbar above the layout and se-
lect Relookup from Student. This updates all of the auto-fill information for the 
current student record, e.g., if you are currently on Johnny’s IEP, that IEP record 
will update. The Relookup from Student feature is not available for the Medicaid 
Logs or Written Agreements.

Printing

Most layouts have a print button on the upper right hand corner (but go to the 
bottom right for Lists or, for Reports, select Continue). Preview your document 
prior to printing by holding the shift key while clicking the print button (let go of 
the shift key after the preview appears). Note whether text needs to be moved 
and then click Cancel to return to your document to make adjustments (depend-
ing on your computer operating system and printer, the preview may not pre-
cisely reflect the printed output). Reports automatically go to preview (no need to 
hold the shift key).
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Multi-page layouts include text boxes with scroll bars and allow substantial room 
for text entry (use Preview to verify that everything prints). One-page layouts, 
e.g., most notices, consents and agreements, do not contain scroll bars and only 
print the amount of text that fits in the original boundaries of the text box, even if 
you type beyond text box borders. 

Print IEP and Print Eval are buttons in the IEP and EPR layouts that allow print-
ing of all, or selected portions, of the document at one time. If you need to select 
a printer other than your default, then uncheck the box on the lower left of the 
Print IEP or Print Eval dialog. This permits selection of an alternate printer before 
each part of the report prints.

User Value Lists

Many forms contain fields with popup menus or lists. Menus are not editable be-
cause they already contain all of the allowable choices but users can edit lists. To 
add items to the popup lists, go to the document that contains the popup list you 
want to edit and then go to Scripts on the FileMaker toolbar and select Edit User 
Value Lists - current area. This takes you to a layout with columns for each of the 
popup lists used in the current section of SpEdDoc (note that the IEP User Val-
ues layout has buttons on the left to access popup lists pertaining to different 
parts of the IEP). Most columns/lists are independent, so don’t bother lining up 
items across unless the columns are linked (as indicated by a blue background). 
List items automatically alphabetize when accessed on the forms.  

To view all of the SpEdDoc User Value Lists at one time, go to the Layout Menu 
at the top of the left hand column (above the book icon) and select User Values. 
You may need to click on the column heading in order to group the items at the 
top of the layout or scroll down to see all of the values that have been entered.

The Services list contains case management and related service items that ap-
pear red on the Services data entry layout. Do not modify these. Modification to 
these items will interfere with the AutoLOC feature for generating Medicaid LOC 
forms.

IEP

IEP Main Menu 

To add items to the popup lists that appear on forms in IEP, click on the Edit User 
Value Lists button. This goes to a layout with buttons on the left side to access 
the IEP popup lists. There are also several IEP reports that can be accessed 
from buttons:
• IEP Dates - view summary of IEP’s with initiation and duration dates.
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• Transition - view summary of IEP’s for students age 16 or older.
• Goal Progress - view summary of progress reporting for selected IEP’s.

IEP Cover Page

If information is complete in Student, much of the top section auto-fills when a 
new IEP is created. Once entered on the cover page, the IEP Meeting Date and 
Initiation Date automatically transfers to Student Main Data. The Annual Review 
Date auto-fills on the cover page based on the IEP Meeting Date, but you can 
override this by manually entering a date. Double-click the Name and Position 
fields to type in them. Single-click to select from a popup list. By default, new IEP 
records show Parent in two locations (change to Adult Student, Guardian or Sur-
rogate, as needed).

Under the print buttons is a Duplicate Record button that creates a new IEP for 
the same student. The new IEP contains the same information as the original, 
except that it excludes most of the dates found on the cover and above the pro-
gress reporting fields. It also excludes progress codes and notes that were en-
tered on the old IEP. This allows retention of the old IEP without having to start a 
new IEP from scratch (do not overwrite the original IEP).

Also on the right side of the layout is a button to create IEP Amendments. Click 
the “New” button to create a document that is similar to the IEP cover page but 
includes additional information concerning changes made to the Annual IEP. 
Team member names transfer from the original IEP, so it will be necessary to add 
or delete names to indicate participation in the amendment. Check the appropri-
ate boxes to indicate the sections amended and, while the changes can be made 
in those sections of the IEP, you may also summarize the changes on the bottom 
of the Amendment document. 

When the IEP document is done, click the Written checkbox to the right of the 
cover page layout. This communicates to other users that the document is com-
plete. There are also a pair of Find buttons that search IEP’s based on the com-
pletion date entered.

IEP Present Levels

There are five sections as a guide to completing this page, but the blue type does 
not print. Each section prints sequentially as separate paragraphs. Big Edit but-
tons are available to the right of the text fields (click on a button to expand a data 
entry box).

IEP Goals
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Enter up to eight progress reporting dates using the mm/yy format. Enter pro-
gress codes in the corresponding columns when reports are due. The DOE pro-
gress code key prints on each goal page. There is also an optional narrative pro-
gress note that prints if you select a print option that includes the note. Access 
the progress narrative field by selecting the Show Note button to the left of the 
Progress Review Dates. There is one narrative note per IEP, so organize your 
entries on a cumulative basis, e.g., enter the date of the current progress period 
before adding note. 

To expedite progress reporting, click the Find IEP Meet <370 Days button on the 
right side of the screen. This finds all the IEP’s with a meeting date in the past 
year. Navigate between IEP’s using the Book icon on the upper left of the screen 
to complete progress reporting. To print the found set of Progress Reports:
• Select a Print Option with Progress.
• Click to the right of the Print button to switch the selection from Page to Recs. 
• Click the Print button.

Enter one goal or objective in each box (putting both in the same box may lead to 
printing problems and complicate reporting). The goal number serves to organize 
your goals and objectives (everything with the same goal number prints to-
gether). For goals, select the New Goal button located below the print buttons 
(number the first goal in an IEP - additional goals will auto-number), write the 
goal, select the appropriate state standard and enter the evaluation procedure. If 
appropriate, indicate that a goal is for Reintegration, Extended School Year or 
Transition by checking the boxes just below the progress code fields. 

To add objectives, select the button on the right hand side of the goal record just 
above the trash can (first make sure the goal has been numbered). Change the 
order in which goals and objectives print by renumbering them. To insert a goal 
without renumbering the existing goals, enter a decimal number, e.g., to insert a 
new goal in between goals 2 and 3, enter 2.1 as the goal number.

Delete any extra or blank goals or objectives using the trash can on the right side 
(leaving blank records will create printing issues). Use the scroll button (with tri-
angular icon) to the right of the goal portal to quickly scroll to the beginning or 
end of the list of goals and objectives.  By default, the Goals layout prints con-
tinuously (Print Options: Continuous) but you can start a new page for each goal 
(Print Options: Break Before Goal). There are two similar options to generate a 
Progress Report. Include a progress narrative note that you may have written by 
selecting Print Options: Continuous Include Note or Break Include Note. Some 

Alternate Edit Screen

Select the Alternate Edit Screen button on the Goals layout to enter goals in a 
customizable environment. This screen includes expansion buttons on the left 
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side that make the fields larger so you can view more of the text (click twice on 
an expansion button to maximize the field size). The screen also includes Dup 
buttons to duplicate a selected goal or objective. Use this to save time when you 
create objectives with similar wording.

Goal and Rubric Banks
While IEP’s can be created without using the Goal and Accommodation Banks, 
the banks are useful when entering the same goal or accommodation in multiple 
IEP’s. It’s also a way for networked users to share goals and accommodations. 
Goals and accommodations can be transferred from the banks to an IEP, but not 
vice versa (unless you copy and paste). So, if you think you’ll eventually want a 
goal or accommodation in the banks, it makes sense to enter it there initially. To 
leave either of the banks and return to the current IEP without transferring any-
thing to it, click the Return button on top of the bank screen.

Goal Bank 

The Goal Bank should be structured similar to one 
(very) large IEP. As with an IEP, each goal should 
have a unique goal number and each objective 
should have both the appropriate goal number and 
an objective number. A major difference from an IEP 
is that student names should not be included (if you 
put names in the bank, they could inadvertently wind 
up in other IEP’s). Further, the goal bank sorts pri-
marily by Author, then secondarily by number (so it’s 
OK for different authors to have the same goal num-
bers).

Access the Goal Bank with the Open Goal Bank but-
ton on the Goals layout of any IEP. Here you can 
view existing goals and enter new ones. To add 
goals to the bank, click on the New Goal or New Ob-
jective button on top of the screen. The New Goal button creates a new record 
with a goal number that is one greater than the highest previously-entered goal, 
e.g., if the highest numbered goal in the bank was 68, then the new one will 
automatically be numbered 69.

The New Objective button creates a new objective record to go with the current 
goal, e.g., if you are on goal number 69, the objective will have a goal number of 
69. The current goal number is indicated to the right of the New Objective button. 
To add an objective to a different goal, first navigate to the desired goal and click 
on the area where text is entered. Since that goal number appears to the right of 
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the New Objective button, clicking the New Objective button creates an objective 
record to go with that goal. Objectives are numbered automatically when select-
ing the New Objective button.
 
Enter goals by typing in the goal text box. Your name as the goal author appears 
automatically based on the User Code entered when you logged into SpEdDoc. 
The Author field is important because goals in the bank are primarily sorted by 
author and secondarily sorted by goal number (consequently, the objectives for a 
goal must reflect the same Author). Enter the Category, Standard and Evaluation 
Procedure (if these items are blank, you will need to enter them each time after 
transferring goals to IEP’s).

Enter data in the remaining search fields for each goal to assist with locating 
goals as the bank grows:
• GE - Grade Expectations code, e.g., W8:3.
• Skill - Basic skill area addressed.
• Set - Identifies goal sets created for shared distribution.
• Level - Local field to distinguish levels, e.g., ECP, Elem, Middle, HS.
• Sub-Category - Place to further break down the Category.

Refer to the student by entering in the Goal Bank as <<STUDENT>>, <<HE/
SHE>>, or <<HIS/HER>> (case sensitive). Don’t put actual names in the bank 
because they could end up in IEP’s for other students. For example, enter in the 
into the goal bank as follows (SpEdDoc automatically translates when the goal 
imports into an IEP):

Goal as entered in Bank:
<<STUDENT>> will read to solve problems: Given any one of the basic shapes 
(circle, square, triangle) and the question, "What shape is this?" <<HE/SHE>> 
will use preferred communication to express the name of the shape on ___ % of 
occasions over __ consecutive trials. 

Goal as imported from Bank into Jimmy’s IEP:
Jimmy will read to solve problems: Given any one of the basic shapes (circle, 
square, triangle) and the question, "What shape is this?" he will use preferred 
communication to express the name of the shape on ___ % of occasions over __ 
consecutive trials.

Clicking in the Category field will pop up a list of any existing category labels in 
the bank. Select from the list or double-click the Category field to remove the list 
and type in the new Category label (the new label will automatically be added to 
the list). Categories added to goals in the bank also appear in the Services page 
Category field.

Click in the Vermont Standard field and, in the next dialog, click Choose to bring 
up a list of Vermont Standards categories (early childhood standards are pref-
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aced with E). Select a category and click Continue. At the next screen you will 
see a list of all the Vermont Standards for the selected category. Click on one to 
transfer it to the goal (if you had previously selected a standard, a dialog asks if 
you want to replace it with the new one). 

The Evaluation Procedure does not have a pop up (click in the field and manually 
enter your criteria). 

Transferring Goals and Objectives to an IEP

Goals in the bank can be transferred to the current IEP (the current IEP is indi-
cated on top of the Goal Bank screen). To change the current IEP, navigate to the 
desired IEP Goal page and select the Open Goal Bank button. Transfer a goal 
along with its objectives using the Enter Goal button to the left of the selected 
goal. If your selected goal includes more objectives than you want, use the Omit 
button to remove the extras before transferring the goal. Or, after you add them 
to the IEP, use the trash can buttons on the Goals layout to delete the extras. Ei-
ther way, if the deleted objectives are not numerically last then you’ll need to re-
number the remaining objectives after transferring the goal to the IEP. Modifying 
goals in the Goal Bank is permanent, while changes made in an IEP are specific 
to that IEP.

To find an existing goal in the bank, click the Find button on top of the Goal Bank 
layout. Then enter one or more search criteria and click Continue to view your 
results. Entering multiple criteria yields a narrower result, e.g., if you enter Read-
ing as your Category and your name as Author, you will only get your own Read-
ing goals. The bigger the bank, the more specific you will want to be in your find 
criteria. It will also help if you refine your categories, e.g., rather than simply Writ-
ing, create categories such as Writing - Responses, Writing - Conventions and 
Writing - Spelling. 

Goal Bank Button Row

• The button row accesses the following features:
Return to IEP: To return to the current IEP without adding goals.

• Enter Goal: To enter the current goal and its objectives (except for any objectives omit-
ted using the Omit button).

• Enter Entire Found Set: To enter multiple goals at once. 
• Collect Goal: To create a found set with just one goal and its objectives.
• Find: To find goals based on the Category or a range of other criteria.
• Show All: To return to the full set of goals.
• All For: To find goals for which you are the Author. 
• Print: To print the found set of goals.
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• New Goal: To add a new goal to the bank (assigned the next available number).
• New Objective: To add a new objective for the current goal.

Rubrics

Rubrics may be created in an IEP or, to reuse in multiple IEP’s, in the Rubrics 
Bank. To create a Rubric for just one IEP:
• Click the Add New Rubric button. 
• Enter enter a Topic.
• Select the IEP Goal (from the current IEP) associated with the Rubric. 
• Select the column headings (selecting the first heading changes the set). Delete the 

last heading if your Rubric only has three levels.
• Click the Add New Row button for each row needed.
• Enter rubric content.
• Click Done to return to the IEP Rubrics layout.
• Click the blue band under a Rubric to expand it.

Click the Open Rubrics Bank button to enter rubrics in the bank or select a rubric to 
transfer to the current IEP. The Rubrics Bank works similar to Rubrics in the IEP, except 
there are additional search fields: Author, Skill (select a basic skill area) and Level (local 
field to distinguish levels, e.g., ECP, Elem, Middle, HS). Select the Enter Find Mode but-
ton to search the bank. Select Return to IEP Rubric to search the bank.

Transition Goals

Transition contains information required for students who will be 16 or older dur-
ing the life of the IEP. Once you enter the IEP Meeting Date on the cover page, 
SpEdDoc provides a red reminder if the student meets the age requirement for a 
Transition plan. The red message remains until you enter enter text in each field 
on the Transition page (with the exception of the last field, needed only for stu-
dents turning 17). Progress codes must be reported for transition goals (either on 
the Transition page or the Goal page, depending on where the transition goals 
are entered).

Services List

The first Services tab, Services List, is the place to list services. Before adding 
services, enter the initiation and duration dates on the Cover Page. Those dates 
appear on the upper left of the Services List screen. The currently selected set of 
dates attach to newly-added services. Use the Custom line to enter a date range 
that differs from those on the Cover Page (e.g., when the IEP is amended). Dates 
can also be edited directly on each service line. The printed services will be 
grouped in chronological order. Dating each service makes it clear when particu-
lar services begin and end.

If the same services are provided during different timeframes (e.g., now until 
June, and then August until the end of the IEP), it is not necessary to retype each 
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service. Instead, enter the services for the first timeframe. Then click on the Du-
plicate Services button to the right of the Services portal. On the Duplicate Serv-
ices screen: 
• Select the new timeframe on the upper left (or enter a custom timeframe). 
• Click the box at the end of each row for the services to be duplicated. 
• Click the Duplicate button to add the services with the new timeframe. 
• Click Done to return to the Services List screen when done duplicating services.

Click in the second column to select the category for each service. This groups 
services for printing in the manner prescribed by the Vermont DOE. Make your 
selection according to the following priority order:
• ESY if Extended School Year Service; if not, then
• Trans if Transition Service; if not, then
• RS if Related Service; if not, then
• SpEd for all other Special Education Services.

Click in the next three Services columns to select from a popup list, or double-
click to type in a different choice. Add to the lists by clicking the Edit User Value 
Lists button on IEP > Main Menu and then clicking the Services button. Some 
service types that can be billed for Medicaid, case management and related serv-
ices, appear in red (but print in black). Personnel Name and Personnel/Provider 
are in the same column. Personnel Name is blue to indicate that it doesn’t print 
on the IEP. It is used to generate reports to assist with Service Plans, scheduling 
and budgeting (go to Student > Main Menu and select the Find Services button). 
By entering the names of personnel along with their titles in User Values, you will 
be able to select the names from a popup list when entering services in IEP’s 
and have the personnel title auto-fill.

Duration and Sessions are entered strictly as numbers in order to automatically 
calculate minutes per week for reports (see Find Services on Main Menu). Enter 
the Frequency by selecting Daily, Weekly, Monthly or Annually (new entries de-
fault to Weekly, so change it as appropriate). Examples:
• If service is three times a week, then Sessions 3, Frequency Weekly
• If twice a month, then Sessions 2, Frequency Monthly
• If service is quarterly, then Sessions 4, Frequency Annually

Enter the group size: Professional small group = 6 or less while Paraprofessional 
small group = 4 or less. Enter the Mode—D: Direct (professional), I: Indirect (e.g., 
para), C: Consult, M: Case Management, A: Assessment. The AutoLOC column 
is used by Medicaid clerks (see AutoLOC Feature in the Medicaid section). The 
trash can button can be used to delete a service line.

Next to the Print Services button are Print Options for printing everything found in 
the three Services tabs or just the current page.
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Services Narrative

The second tab in this section includes several narrative items. The Narrative 
field can be used to describe services in more detail. The placement field in-
cludes a popup menu that corresponds to the placement list on Student: Main 
Data (if the selection differs from Main Data, a button appears - click it to update 
Main Data to match the new IEP). The participation field offers a popup list. To 
add items to the popup list, go to IEP: Main Menu and click on the Edit User 
Value Lists button.

Accommodations

The third tab in the Services section includes Accommodations. Identify any pro-
gram modifications or supports for personnel in the first field. The second field 
provides a narrative field for describing accommodations. This field is unneces-
sary if you detail the accommodations in the following section. 

Check one of the assessment boxes. If you check the first box, be sure to indi-
cate which accommodations will be used for state assessments and/or NDS (na-
tional, district and school assessments) by selecting the appropriate boxes after 
each accommodation. 

Enter one accommodation per text box (entering multiple accommodations in one 
text box may exceed the printing capacity).  Accommodations print grouped by 
category, starting with Testing and then other categories alphabetically (but items 
without a category name assigned print first). There are three Print Options (only 
the third option prints the Review columns). 

Accommodations Bank

The Accommodations Bank works much the same as the Goal Bank. Accommo-
dations can be transferred from the Accommodations Bank to an IEP, but not vice 
versa (except, of course, through a copy and paste process). So, if you think 
you’ll eventually want an accommodation in the bank, it makes sense to enter it 
there initially. A major difference from the Goal Bank is that the Accommodations 
Bank is available to 504 Plans in addition to IEP’s. Another difference is that the 
Accommodations Bank is a list of separate accommodations, whereas the Goal 
Bank has objectives linked to goals. Consequently, selecting the “Enter Accom” 
button transfers just the selected accommodation to the current Plan. Further-
more, you stay in the Accommodation Bank until done selecting accommodations 
(a brief flash of the screen indicates that each accommodation transfers to the 
Plan at the time it is selected). 
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Access the Accommodations Bank using the Open Accom. Bank button on the 
Accommodations layout (IEP > Services > Accommodations or from the 504 
Plan). Here you can view any accommodations that have been entered (SpEd-
Doc comes with a set of 138, including 31 NECAP allowable accommodations) or 
you can enter new ones. To add accommodations to the bank, click on the New 
Record button on top of the screen. To return to the current Plan without transfer-
ring anything to it, click on the Return button on top of the screen.  

To search the bank, use the Find button on top of the Accommodations Bank lay-
out. Then enter one or more search criteria and click Continue to view your re-
sults. Click an “Enter Accom” button to transfer an accommodation to the current 
Plan (the accommodation will be added to the Plan but you will remain in the Ac-
commodations Bank so you can select more). Click on the Return button to re-
turn to the Plan when you are done adding accommodations to the Plan. In the 
Plan, you can use the trash can button on the Accommodations layout to remove 
any that were mistakenly transferred to the Plan. Modifying accommodations in 
the Accommodations Bank is permanent, while changes made in a Plan are spe-
cific to that Plan.

IEP-at-a-Glance

Some schools may choose to print a condensed IEP-at-a-Glance document for 
some staff in place of the entire IEP. This feature is accessed through the Print 
IEP or At-a-Glance button on the IEP pages. The document includes some infor-
mation from the Cover Page, Present Levels (checking boxes to the right of Pre-
sent Levels text boxes include those portions), Goals (but not objectives), Serv-
ices and Accommodations.

Services Plan

The IEP form may be modified into a Services Plan for home and private school 
students simply by checking the box in the upper left hand corner of the IEP 
Cover Page. Then the desired portions of the IEP form may be completed and 
printed to create the Services Plan. For instance, a plan might consist of the fol-
lowing four pages: Cover, Present Levels, Goals and Services.

IEP Consents and Notices

Consent

Consent for Initial Provision of Special Education Services is a one-page form 
(fields do not expand for printing). The form now incorporates consent for EEE 
placement from FITP (the separate form has been eliminated). The placement 
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can be described in two lines or less. Most of the fields auto-fill based on infor-
mation entered in Student. 

Tip: Enter today’s date by clicking in a field and then keying Command-Dash 
(Command -). 

LEA Refusal

Notice of LEA Refusal contains four narrative fields that expand to include all the 
text you enter (those fields contain scroll bars once you exceed the original 
boundaries). The Procedural Safeguards Contact can be selected from a popup 
by clicking on the name field (if the name and contact information have been en-
tered in the User Values – Main Menu > Edit User Value Lists > Other), or you 
can type it in (typically, the special education director is the contact for the SD/
SU).

Not Attending (Written Agreement)

Written Agreement for Not Attending an IEP Meeting is a form to agree that an 
IEP team member will not attend a meeting. Create a new form by clicking the 
Not Attending button and then, in the ensuing portal, the New button. Click on the 
Go button in that portal to view and edit the newly-created agreement. You can 
also view existing Written Agreement records (but can’t create new ones) in Stu-
dent > Portals.

IEP Revisions (Written Agreement)

Agreement to Revise the IEP Between Annual Review Meetings is a form to 
agree to an IEP change without a meeting. Create a new form by clicking the IEP 
Revision button and then, in the ensuing portal, the New button. Click on the Go 
button in that portal to view and edit the newly-created agreement. You can also 
view existing Written Agreement records (but can’t create new ones) in Student > 
Portals.

Evaluation Plan and Report

Eval Main Menu 

To add items to the popup lists that appear in the Evaluation file, click on the Edit 
User Value Lists button on the bottom of Evaluation: Main Menu. This takes you 
to a layout with columns for each of the Evaluation popup lists. Additionally, in-
formation auto-fills when a disability is selected in the Disability Determination 
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section. This information can be modified by selecting the Evaluations Questions 
button on Student > Main Menu (access requires a higher level password). 

Cover Page

If information is complete in the Student file, much of the top section will auto-fill. 
Once entered, the Date of Report will automatically transfer to Student. Note that 
the form now includes a place to record the date that consent for testing is re-
ceived. Double-click the Name and Position fields to type in them. Single-click to 
select from a popup list. The User Value lists for the bottom part of the form (be-
low the required team members) are Participant and Participant Title. There is a 
Yes/No popup to indicate who was involved in developing the plan, but partici-
pants are expected to initial agreement with the decision (or submit a dissenting 
report).

Also on the right side of the layout is a button to create an EPR Amendment to 
document reconvening the team in order to review assessment results that were 
received following the Eligibility Decision meeting. If the team is determining a 
new primary disability, develop a new EPR rather than using this form. Click the 
“New” button to create a document that is similar to the cover page but includes 
additional information concerning changes made to the EPR. Team member 
names transfer from the original EPR, so it will be necessary to add or delete 
names to indicate participation in the amendment. Summarize the changes on 
the bottom of the Amendment document. The purpose of the Amendment 

When the EPR document is done, click the Written checkbox to the right of the 
cover page layout. This communicates to SpEdDoc users that the document is 
complete. There are also a pair of Find buttons that search EPR’s based on the 
completion date entered.

Disability Determination

This section has tabs for up to five disability areas. Click on a tab to select a sus-
pected disability. Questions auto-fill based on the disabilities selected on the tab 
(click in the fields to edit the auto-filled text). Type answers in the same field 
along with the questions. Enter the conclusion in Section B. Click the Section C 
popup to view to select from the eight assessment areas and titles of those re-
sponsible. A Big Edit button is available to the right of the Questions and Answers 
text field (click on a button to expand the data entry box). If you select multiple 
disabilities, each disability will have its own tab. Click on a tab to edit the informa-
tion for that disability.

There are three print buttons on top of the layout (use the third option for a very 
long Disability Determination section that otherwise exceeds FileMaker printing 
limits):
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• Page: Print the current layout (one disability area).
• All: Print the entire Disability Determination section.
• Eval: Go to a dialog to print all or portions of the evaluation report.

Adverse Effect

This section has tabs for up to nine basic skill areas (regulations only require 
documentation of adverse effect in one basic skill for eligibility). Click on a tab to 
select a basic skill area of concern. Required questions are built into the form (al-
though additional questions may be entered into the Section A). If the team elects  
not to consider a question, deselect the checkbox to the right of that question so 
it doesn’t print. Click in the Section D popup to view and select from the six as-
sessment areas that will be considered for the selected basic skill and to indicate 
who will be responsible for each area. Section D always prints for the first tab, 
since it is acceptable to make a single list of assessments for all the basic skills. 
However, Section D will also print on any of the remaining tabs if data is entered 
in the Assessment or Responsible fields.

Need for Special Education

Questions auto-fill based on the disabilities selected on top of this form. Click in 
the fields to edit the auto-filled text. Big Edit buttons are available to the right of 
the text fields (click on a button to expand the data entry box).

Decision

Document the team’s decision. This page includes a written prior notice state-
ment. Be sure to also update the primary and secondary disabilities on Student 
Main Data.

Evaluation Consents and Notices

Eval Notice

Notice of a Special Education Evaluation is a one-page form (fields do not ex-
pand for printing). The form provides notice of an evaluation for eligibility or other 
purposes. Most of the fields auto-fill based on information entered in Student. 

Eval Consent

Consent for a Special Education Evaluation is a one-page form (fields do not ex-
pand for printing). All but the date field auto-fills based on information entered in 
Student. 
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Evaluation Delay

Notice of Evaluation Delay is a one-page form (fields do not expand for printing). 
The form is restricted to initial evaluations since re-evaluations are no longer sub-
ject to the 60-day rule (they still need to be completed within three years of the 
prior evaluation). This is a one-page form, so fields do not expand for printing. 
Most of the fields auto-fill based on information entered in Student.

No Re-evaluation (Written Agreement)

Written Agreement Between Parents and District – Re-evaluations is a form to 
agree that eligibility will be re-determined without an evaluation. Create a new 
form by clicking the Written Agreement button and then, in the ensuing portal, the 
New button in the No Re-evaluation section. Click on the Go button in that portal 
to view and edit the newly-created agreement. You can also view existing Written 
Agreement records (but can’t create new ones) in Student > Portals. Be sure to 
enter the parental signature date in Student > Tracking > Most Recent Eval. so 
that the next triennial date can be calculated.

Transfer Student (Written Agreement)

Completion of an Evaluation of a Transfer Student is a form to agree that an ini-
tial or re-evaluation of a transfer student will be completed later than would ordi-
narily be required. Create a new form by clicking the Written Agreement button 
and then, in the ensuing portal, the New button in the Transfer Student section. 
Click on the Go button in that portal to view and edit the newly-created agree-
ment. You can also view existing Written Agreement records (but can’t create 
new ones) in Student > Portals.

Meeting

The Notice and Minutes forms include a Duplicate Record button to create a new 
record. Use this if you want to retain the old record in the database while creating 
a new Notice or Minutes form. The Duplicate Record feature retains some data 
from the original form, e.g., the names of meeting participants.

Meeting Main Menu

To add items to the popup lists that appear on forms in Meeting, click on the Edit 
User Value Lists button. This takes you to a layout with columns for each of the 
Meeting popup lists that are user editable. 
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Notice

The meeting date and time will appear bold. You may optionally enter an end 
time for the meeting. Double-click the Name and Position fields to type in them. 
Single-click to select from a popup list. The User Value lists for the bottom part of 
the form (below the required team members) are Participant and Participant Title.

Tip: Save time by allowing the program to auto complete data. For instance, en-
ter 11/15 and the program will auto fill Monday, 11/15/04. Enter 10 for 10:00 AM 
or 10pm for 10:00 PM (FileMaker assumes AM unless you enter PM).

Minutes

This is not a state-mandated form. The Minutes form may be used to take min-
utes during a meeting (there is capacity to print 10 pages of minutes for a meet-
ing). Other users prefer to print the form to bring to the meeting as a cover page 
for minutes. The list of names on the Notice automatically appears on the Min-
utes form. After the parent name, there is a place for the parent to initial that s/he 
was informed of parental rights.

Next Steps

This form is used to invite parents to their first IEP meeting when the child is 
transitioning from FITP to EEE.

Medicaid

Access the Medicaid records through the second tab on Student: Portals. Since 
the logs are now separate from the main Medicaid record, you only need one 
Medicaid record per student while you may have multiples of one or more of the 
provider forms. Detailed instructions for the Medicaid forms are in the SpEdDoc 6 
Medicaid Guide.

Section 504

Access the Section 504 forms through the third tab on Student: Portals. The Sec-
tion 504 forms are largely self-contained, i.e., they are a complete set of forms 
independent of the various special education forms elsewhere in the database. 
However, all students, including Section 504, need to be entered on the Main 
Data layout in Student before proceeding (disregard those fields that only apply 
to special education). Several forms that list team member names have a Fill 
from Meeting List button to transfer the names you entered on the Section 504 
Meeting Notice to the current form.
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504 Main Menu

To add items to the popup lists that appear on forms in Section 504, click on the 
Edit User Value Lists button. This takes you to a layout with columns for each of 
the Section 504 popup lists that are user editable.  The Section 504 Coordina-
tor’s name and contact information are blue on the User Value List to indicate 
that the adjacent name and address are related. Once entered in User Values, 
selecting the coordinator’s name on the 504 Main Menu will automatically enter 
the coordinator’s name and contact information on the following two forms for 
students attending that school: “What is Section 504” and “Summary of Parent/
Student Rights.” Access these two documents by clicking the buttons on any of 
the 504 Evaluation layouts under the print buttons (the documents are not stu-
dent specific, so could be reproduced for future use). 

The student-specific Section 504 forms include:
Evaluation section:
• Evaluation Report – To document the evaluation process and conclusion.
• Referral – To refer a student suspected of having a 504 disability.
• Referral Notice – To notify parents that the 504 process is commencing.
• Notice and Consent – To obtain parental permission for a 504 evaluation.
• Decision Notice - To notify parents of a decision regarding a 504 disability.
Meeting and Minutes section:
Meeting Notice – To notify parents of a 504 meeting and its purpose.
Minutes – To document meeting discussion and decisions.
Plan section:
• Plan – To document what will be done to support a 504 student.

Once entered on forms, the dates show under the corresponding form buttons. 
This provides an indication of which forms have been completed.

Keyboard Shortcuts
There are a variety of time-saving keyboard shortcuts (some are also available 
from the FileMaker toolbar). Here are a few commonly-used shortcuts:

• Control - X (Mac: Apple - X) – Cut
• Control - C (Mac: Apple - C) – Copy
• Control - V (Mac: Apple - V) – Paste
• Control - - (Mac: Apple - -) – Enters today’s date
• Shift - Print button – Shows preview of the current layout
• Right click (Mac: Control click) on word with red underlining to show a contex-
tual menu with Suggested Spellings (FM8 or newer).
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• Right click (Mac: Control click) on a field to show a contextual menu with an op-
tion to Cut (clear the data).
• Right click (Mac: Control click) on the vertical band on the left hand side of the 
FileMaker toolbar to add or remove toolbars (Standard and Text Formatting are 
available).

FileMaker Versions

While there is just one current SpEdDoc version, there are expanded feature sets  
for users with updated versions of FileMaker. Here are some of the additional 
SpEdDoc features available to users with FM8 or newer:

• Improved spell checking (underlining of suspect words as you type).
• Pop up calendars for date fields (click the date field and then the calendar icon).
• Email messages directly from Contact Logs.
• AutoLOC feature and line-level LOC trash cans.
• Select Assessments button on Disability Determination pages.
• Tabbed document access in Student Portals.
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